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Introduction 

This user guide is intended to show how to use InScribe to both type and edit using ShadowScribe Automated Speech 
Recognition (ASR) and assumes you already know InScribe. 

ASR is the technology used to create draft transcriptions. Drafts require a skilled person to review and make corrections 
to transform the draft into a complete, medically accurate document. 
 

Since drafts are already transcribed, the first action is to read rather than type. Because reading is faster than typing, 

transcriptions can be completed quicker. You only need to edit what is incorrect. This process improves productivity as 

less time is spent on straight typing. The system also automates document formatting at both the content level (formatting 

dates, numeric quantities, frequencies and ranges to name a few) and style level, (formatting section titles - bolding and 

casing, content placement, and more). This automation further improves productivity and frees you, the MT/MLS, to 

concentrate more on the medical content of the document. 

Note: This guide assumes the “Use ASR-Enhanced Shortcuts” is enabled in InScribe and will refer to these shortcuts 

throughout. To verify that you have these set, go to the Options Menu, Shortcut Keys. Under the Options section, make 

sure the shortcuts drop down is set to “Use ASR-Enhanced Shortcuts”. 
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Brief Overview of How ShadowScribe Works 

A clinician will dictate and record the narrative of a patient encounter into an audio file. This audio file will be sent to the 
ShadowScribe Automated Speech Recognition (ASR) system, which transforms the audio into text as a draft transcription.  

During the draft generation process, the draft will be assessed to determine whether it should be released for editing. 
Drafts are released unless the quality results in a greater editing effort, in which case, only the audio will be released for 
straight typing. After the draft has been edited, it may go through additional levels of QA or be delivered to the client as a 
final document. Upon delivery, the final document is split into two copies. One copy goes to the client for their workflow, 
while the other goes back to the ASR system for learning. During the learning process, the system will compare and 
analyze the edited draft with the original, using the MLS corrections to continually improve upon the quality of drafts over 
time. 
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Typing in the Structured Format 

The process for typing Structured ShadowScribe ASR jobs is conceptually the same as typing unstructured jobs. The job 

will load into your dictation queue, you’ll play the audio and type into the editor as you normally do. If used, document 

and/or dictation templates work the same as well, but may look different if they are structured. What does change is: 

1) how the content you type into the editor will appear when working with section and subsection titles, and 

2) you will follow a StyleGuide for formatting certain types of content.  

In the case of a structured formatted job that has no titles, such as a letter, there is no difference in appearance.  

 

When titles are added, the text will appear below the title under a gray dashed line. 
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The appearance may not follow the client’s desired formatting at first look; however, formatting is applied after the job is 

delivered to the client, or if you do a “preview transcription” as the example below shows. Formatting is set up ahead of 

time by the account manager or transcription company through the format rules interface. The MT or MLS is not 

responsible for setting up this formatting.  

 

Working with Sections, Subsections, and Numbered Lists 

During your work, you will likely need to add, remove, and manipulate sections and numbered lists. The section functions 

are found both under the Data tab in the Sections Menu as well on the editor toolbar. The numbered list function is found 

on the editor toolbar. 

 

Although you can use the mouse to utilize any of these functions, you are strongly encouraged to use the shortcut keys, 

as this will help you increase efficiency and productivity especially when editing. Because shortcuts are extremely 

important, we emphasize them as we explain how to use each function, breaking the menu into categories.  
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Inserting Sections: 

If the clinician speaks a section like “History of Present Illness”, this is your cue to add a section.  

To do this: 

1. Use the CTRL + N shortcut. The Section Properties dialog will appear. Type the entire title name or use SHIFT + 
ALT + DOWN ARROW  for a drop-down list of preloaded titles. Type a few characters of the title to quickly 
locate it in the list. 

 

No drop-down list     With drop-down list 

 
2. Hit ENTER to insert the title into the editor. 

3. The cursor appears below the gray dashed line of the title where you will start typing. 

The content always appears below the dashed line even if it is supposed to appear to the right. Remember, the 

formatting is set ahead of time. 

Inserting Subsections 

If the clinician speaks a section like “Physical Examination” followed by a subsection like “Vital Signs”, this is your cue to 

add a subsection.  

To do this: 

1. Use the SHIFT+ CTRL+ N shortcut. The Section Properties dialog will appear. 

2. Type the entire title name or use SHIFT + ALT + DOWN ARROW to access the drop-down of preloaded titles. 

Type a few characters of the title to quickly locate the title in the list.  



 

 

    

    

9 

eScription One 
 

 Jan 2020 

 

© 2020 Nuance Communications, Inc. All rights reserved. 

3. Hit ENTER to insert the title into the editor. Notice the title now appears italicized. This visually denotes a 

subsection. The cursor will appear under the gray dashed line where you start typing. 

 
Converting from Subsections to Main Sections and Main Sections to Subsections 

There may be cases where you need to switch from a subsection to main section or go from a main section to subsection. 
This is very easy to do without deleting and retyping the text.  
 

To convert from Subsection to Main Section: 

1. Place your edit cursor in the subsection you wish to change. 
2. Use CTRL + , (comma) to promote (convert) the subsection into a main section. 

 
BEFORE 

AFTER 

 

To convert from Main Section to Subsection: 

1. Place your edit cursor in the section you wish to change. 

2. Use CTRL + . (period) to promote (convert) the main section into a subsection. 

 

BEFORE 

 

AFTER 
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Reordering Sections 

Sometimes you may need to change the order of the sections in the document. Note: This should be done only if 
absolutely necessary. Putting sections in a different order than dictated can cause recognition issues with ASR.  

 

To do this:  

Move Section Up: 
1. Place your edit cursor in the content box section you want to move. 
2. Use CTRL+ALT+,(comma) to move the section up above the prior section. 
 

As you keep using this shortcut, the entire section will continue moving above the next prior section. 
 

Move Section And Sub-Sections Up: 
1. Place your edit cursor in the content box section you want to move. 
2. Use SHIFT + ALT +, (comma) to move the group up above the prior section. 
 

As you keep using this shortcut, the entire group will continue moving above the next prior section. 
 

Move Section down: 
1. Place your edit cursor in the content box section you want to move. 
2. Use CTRL+ALT+. (period) to move the section down below the next section. 
 
As you keep using this shortcut, the entire section will continue moving below the next subsequent section. 
 

Move Sections and Sub-Sections Down: 
1. Place your edit cursor in the content box section you want to move. 
2. Use SHIFT + ALT +. (period) to move the group down below the next section. 
 

As you keep using this shortcut the entire group will continue moving below the next section. 

Removing Sections and Subsections 

Sometimes it may be necessary to remove a section or subsection.  There are two methods for doing this. The first 
method, “Delete Section” (aka remove by conversion), converts the section title into plain text and moves it into the prior 
section. The second method, “Delete Section and Contents” (aka remove by deletion), completely removes the entire 
section and all its contents.  
 

Delete Section  

This method is often used when editing drafts but can be used when typing jobs. 

 

To do this: 
1. Place your cursor in the section or subsection you want to remove. 
2. Use SHIFT + CTRL + \. The title text is converted into plain text, where it can be highlighted and deleted. 
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BEFORE REMOVAL 

 

AFTER REMOVAL 

 

 

Delete Section and Contents 
This method is more commonly used when typing but can be used when editing jobs. 

 

To do this: 

1. Place your cursor in the section or subsection you want to remove. 

2. Use CTRL + ALT + \.The title and all content are removed.  

 

BEFORE REMOVAL 

 

AFTER REMOVAL 
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Renaming Sections and Subsections 

Sometimes it may be necessary to rename a section or subsection because it was mistyped, or the clinician made a 

correction. 

To do this: 
1. Put the edit cursor in the content box of the title to be renamed. 
2. Use CTRL + F6. The Section Properties dialog will appear. 
3. Type the name of the new title, or select it from the predefined drop-down list, if one exists. 

 

 
 

4. Hit ENTER. The new title appears. 
 

 

 

Inserting a Red Section 

Red sections appear when adding a section that is not part of the document type’s list of predefined sections. This usually 
occurs when the clinician dictates an undefined section. Always add the section in correct grammatic title case: e.g., type 
“Immunizations and Allergies” instead of “IMMUNIZATIONS AND ALLERGIES. Title case ensures that the system will 
apply the correct formatting on document delivery. 
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Moving between Sections 

To move the edit cursor forward, use CTRL + DOWN ARROW or TAB. For smaller movements, single line at a time, use 

DOWN ARROW.  

To move the edit cursor backward, use CTRL + UP ARROW or SHIFT + TAB. For smaller movements, single line at a 

time, use UP ARROW. 

Working with Lists 

Under certain section headings, a list may be dictated. When lists are added, they always appear bulleted. You should not 
remove the bullets and manually type numbers unless explicitly instructed by your supervisor. The bullets will be 

converted into numbers at time of delivery. You can also see the numbers if you do a preview with transcription. 

 

Inserting a List 
The list option is located under both the Format Tab and on the toolbar. Again, we will emphasize keyboard shortcuts with 

this function. 
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To do this: 

1. Place your cursor under the appropriate section or subsection. 

2. Use CTRL + L to add the list item. 

 

 

Remove a List 

To do this: 

1. Place your cursor on the list item to remove. 

2. Use CTRL + L to remove the list item. 

Using Autotext 

Autotext should be used as an efficiency tool and should consist of words, phrases, sentences or paragraphs.  

Autotext containing template formatting or numbered lists should not be used. Using this will cause issues with ASR 

learning. If you have autotext that has either formatting or numbered lists, talk with your supervisor about converting this 

into a structured document or dictation template. 

 

Example of autotext that SHOULD NOT be used 
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Formatting Rules 

Transcription formatting rules control the style formatting of the document and transform it into the client’s desired look. 

These rules apply to the structure items in the transcription, which include sections, subsections, content placement and 

numbered lists. When the rules are applied, they control formatting such as title bolding, title casing, and placement of 

section content to name a few. The rules are set up ahead of time and are applied at time of delivery. Therefore, it is 

unnecessary to format any text, numbered lists, sections, or subsections. 

If you wish to see the transcription with the formatting applied, you can use the Preview Transcription option (Ctrl+Alt+B) 
under the InScribe file menu. 

 

Using Structured Document Templates 

Document template use is determined by client requirements and is set up ahead of time. If used, there are two cases 
when you will see them. The first is when the client requires certain sections to be part of a dictator’s transcription, 
whether dictated or not (aka a mandatory section). The second case is when a section contains canned text. Canned text 
will appear in yellow highlight. This text may or may not be counted as qualified text. For questions on qualified text 
contact your transcription company supervisor.  

Document templates can appear as a full template, where all the sections for the document type appear, or as a partial 
template, where only certain sections appear. The screenshot below shows a template with both canned text and required 
sections. All sections and subsections shown are required. 
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In a partial template, only certain required sections will appear or those that have canned text. For example, the client 
might require only the “History of Present Illness” and “Medications” sections always be part of the transcription, but the 
rest of the sections could vary. 

Using Structured Dictation Templates (or Normals) 

Structured dictation templates have the same purpose and are used in the same manner as regular dictation templates, 
however, structured templates appear in the structured format. 

Inserting a Structured Dictation Template 

To do this:  

1. Place your cursor in the appropriate section or subsection. 

2. Use the CTRL + ALT + G combination to make the dictation templates dialog appear.  
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3. Select a dictation template from the pop-up window and click ‘Insert and Close’. Or click ‘Insert’ if you wish to 
have the pop-up window remain accessible for other templates.  

 

The StyleGuide 

When typing (and editing) certain types of content, it is important the MT/MLS team adheres to specific formatting rules. 
This ensures that ASR learns to incorporate the correct formatting into future drafts. The StyleGuide is a document that 
keeps the MT/MLS team aligned on a formatting standard and is agreed upon by the client ahead of time. When you start 
a new client, your supervisor should provide this document as part of your account specifics for the client. Below is a 
sample set of what these rules can look like. For example, if you’re typing (or editing) a quantity, you would type the 
quantity in Arabic Numerals.  
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If working for multiple clients, it may be possible to have more than one StyleGuide. Be sure to apply the appropriate 
StyleGuide for the client and adhere to it as closely as possible.  

 

Notes Regarding the StyleGuide 

1) The StyleGuide is a guide for the MT/MLS team to follow. If the team consistently types (or edits) something that 
deviates from the StyleGuide, ASR can learn this. In fact, almost everything in the StyleGuide can be learned by ASR 
correctly or incorrectly. In some cases, a client may agree to a StyleGuide but require certain items to be formatted 
differently. In such cases, it may be necessary to type (or edit) against the StyleGuide. Your supervisor will inform you if 
this is necessary. 

 

2) There are two exceptions to StyleGuide learning which apply to date and patient formatting. ASR will not learn different 
formatting from consistent typing (or edits) on these specific rules. The system will always follow the StyleGuide for these 
two items.  
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Drafts in the Structured Format  

When a draft appears in InScribe, it will appear in the editor, and at first glance looks like an almost complete job. The first 
thing you’ll likely notice are the structured items that make up the framework of the document: section headings with 
corresponding text, numbered lists, subsections, etc. Note, there can be cases where there are no section headings. This 
usually occurs with letter type documents which typically contain paragraphs of text. 

 

The next thing you may notice are the patient demographics and CC’s area. ShadowScribe ASR does not automatically 
populate these areas from the recognition. It is the MT/MLS’s responsibility to add this information. However, with many 
clients using mobile devices or using patient schedule feeds, filling in the demographics can be done quickly. 

When working with drafts, except for working in the editor, everything with InScribe functions the same as if you were 

typing the job from scratch. 

Components of a Draft 

Every draft has two main components: the Framework and Content. Framework components consist of section and 
subsection titles, numbered lists, and content placement - anything that makes up the layout of the document. Content 
components refer to the specific text of the narrative. This can be the content belonging to a section in a letter type format 

or paragraphs of text. The example below shows the parts of a consult type draft. 
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Draft Formatting Styles 

Both framework and content components have formatting styles. These styles produce the client’s desired document look 
and feel, and are applied automatically when the draft is created.  

Formatting styles of Framework components consist of things such as bold, italics, underline, and casing of 
section/subsection titles, as well as ordering of the titles. Framework components also handle content placement and 
numbered list formatting.  

Content placement handles the location of recognized narrative text relative to the section title. It determines whether 
content appears below or to the right of a title. Numbered list formatting controls whether a list should appear indented or 
flush left. Keep in mind, with letter type documents framework, formatting is not as pronounced since letters usually 

contain paragraphs of text.  

Styled content components, on the other hand, are specific to certain kinds of narrative text. These are things like dates, 
abbreviations, numeric quantities, frequencies, and ranges to name a few.  

 

With structured documents, all content styles are applied immediately to the draft while framework styles are applied upon 
delivery. Remember, you can also use preview transcription to see what the styles look like when applied with CTRL + 
ALT + B or via File menu: File > Preview Transcription. The screenshot below shows the formatting applied. 
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Formatting for both framework and content are set up ahead of time per client requirements. The goal with the draft 
formatting is to shift much of the formatting responsibility to ShadowScribe ASR, and to free you to concentrate more on 
the medical accuracy of the draft. 
 

Brief Editing Walkthrough 

When reviewing drafts, you begin by reading and listening to the audio. The first thing you might notice is the voice cursor. 

 

This moves over the text while the audio is played and helps to focus attention to the text and audio as you read and listen 
to the dictation. The voice cursor also helps improve editing efficiency because it can be attached to the edit cursor and 
carried along with the playback. The voice cursor will be covered in more detail later in the section Using the Voice 
Cursor. 

The next thing you may notice is the framework of the document: section titles, content placement, or numbered list items. 
You may find that a title may not have been recognized properly, or maybe a numbered list isn’t formatted correctly, such 

as in the example below. Framework edits are usually more obvious to spot.  
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Once done with any framework edits, your focus turns to the content. Content edits are usually identified by listening to 

the audio. The example below is a content edit. In this case, the word “numbers” should have been “numbness”. 

 

Whether the edit is obvious or not, your objective is to locate, move to, decide on the type of edit – framework or content – 
and execute the edit as efficiently as possible. This should be the pattern followed until all edits have been made.  

 

The Editing Mindset 

Editing and typing a document require two separate mindsets. When typing, you work in an environment where your 

hands are always moving. You listen to the dictation and convert words you hear into text. When editing, ASR has already 

converted the words to text, so your first action is to read. You look at words, phrases, sentences, and their context to 

understand and verify meaning. As you locate edits, you identify whether they are framework, grammatical, contextual, 

etc., and then make the edits. To effectively work in drafts, a new set of skills is needed.  

Beginning Editing Skills  

Editing skills can be broken into two categories: beginning and advanced. In this section, we cover the beginning editing 

skills, which focus on using keyboard shortcuts for navigating and editing. These are the core skills that all beginners 

should learn.  
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Why Keyboard Shortcuts 

Keyboard shortcuts are one of the most important tools for editing efficiently. When you edit, you want to rely on the 
mouse as little as possible because the mouse will take away from productivity. It may not seem like a lot of effort to use 
the mouse, but consider this: if you move your hand from the keyboard, to the mouse, position the cursor, then move your 
hand back to the keyboard, you lose seconds of productivity which can add up to minutes throughout the day. Those 
minutes could be the difference of additional reports completed by the end of the day. For a better understanding, look at 
this simple example: 

Imagine your edit cursor is after the word “Jones”, highlighted in green, and you want to delete the word “leukocytosis”, 
highlighted in yellow. 

These are the steps to make the edit using the mouse: 

1) Remove hand from keyboard. 

2) Place hand on mouse. 

3) Move mouse to the word “leukocytosis.” 

4) Highlight the word “leukocytosis.” 

5) Move your hand off the mouse and back to the delete key on the keyboard. 

6) Press delete. 

 

Now, compare that with the steps using only the keyboard: 

1) Hit the CTRL + DOWN ARROW twice to place the edit cursor in front of the “F” in Fever. 

2) Hit the END key, which places the edit cursor at the end of “leukocytosis”. 

3) Hit the CTRL + BACKSPACE key twice. Once to delete the period, second to delete the word. 

Notice the difference. Using the keyboard, we didn’t lose any seconds moving our hand to grab the mouse. We kept our 
hands on the keyboard the entire time and did the same edit in half the steps. 

The next three sections break down what we call the “core editing” shortcuts. 

Navigation Shortcuts 

These shortcuts are meant to take the place of the mouse for quickly moving the edit cursor to the spots that need 
corrections. 

CTRL + ↑            Move edit cursor Up one Paragraph 

CTRL+ ↓             Move edit cursor Down one Paragraph 

CTRL + →          Move edit cursor one whole word right 

CTRL + ←          Move edit cursor one whole word left 
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Ctrl + Home       Move edit cursor to the top of report 

Ctrl + End          Move edit cursor to the bottom of report 

Home                 Move edit cursor to beginning of line 

End                    Move edit cursor to end of line 

Editing Shortcuts 

Use these shortcuts to delete whole words (instead of characters), to select words, and to move words around. These 
shortcuts will help you quickly execute edits, fixing misrecognitions and errors. 

Ctrl + Delete     Delete one whole word right of edit cursor 

Ctrl + Backspace        Delete one whole word left of edit cursor 

CTRL + X, C, V, Z        Cut, Copy, Past, Undo 

CTRL + U                     Toggle case of word between Sentence Case, Lower Case, and Upper Case 

 

SHIFT + ____ 

Add Shift to any of the navigation keys for selection. E.g., Shift + Ctrl + → to 
select one whole word right 

Playback Shortcuts 

While you can use the foot pedal to control playback, if you are planning on editing, you are encouraged to use the 

playback keyboard shortcuts. There are shortcuts to play, stop, rewind and fast forward as well as shortcuts that allow you 

to control the playback speed. These shortcuts complement editing and navigation shortcuts nicely and can further help 

efficiency. 

F2 or CTRL + SHIFT + X Play and Pause 

F3 or CTRL + SHIFT + C Rewind 

F4 or CTRL + SHFIT + V Fast Forward 

CTRL + E Slow down playback rate 

CTRL + T Speed up playback rate 

CTRL + R Return playback rate to normal 

Also, using the keyboard gets you into a better mindset because all playback, as well as typing and editing functions, are 

controlled from one place. 
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Shortcuts to learn first  

Between navigation, editing, and playback, there are many shortcuts to learn. Plus, there are additional shortcuts for 
advanced editing covered later in this document. It can seem like a daunting task to learn these at once. That’s not the 
goal here. Working with shortcuts is a skill that takes practice. The strategy is to start off slowly; learning a few shortcut 
keys, and working with them until you are comfortable, then slowly adding a few more. Keep following this strategy until 
you have built up your shortcut repertoire.  

Here are the recommended core editing shortcuts to start with. Keep it simple and start with just the Navigation Keys 
(Paragraphs and Words). Try incorporating them into your editing work daily. Once you are proficient with these, move on 
to Navigation Keys (Larger movements) and then to the Editing Keys. Getting these under your belt will be a good 
foundation to learning other advanced shortcuts, such as using the voice cursor. 
 

•CTRL + ↑                    Move Edit Cursor Up one Paragrah

•CTRL+ ↓                     Move Edit Cursor Down one Paragraph

•CTRL + →                  Move edit cursor one whole word right

•CTRL + ←                  Move edit cursor one whole word left

1) Navigation Keys (Paragraph and Words)

•Ctrl + Home                Move edit cursor to the top of report

•Ctrl + End                   Move edit cursor to the bottom of report

•Home                          Move edit cursor to beginning of line

•End                              Move edit cursor to end of line

•CTRL + F                     Bring up find dialog, type word/phrase to find and move 
edit cursor to that part of document

2) Navigation Keys (Larger movments)

•Ctrl + Delete                Delete one whole word right of edit cursor

•Ctrl + Backspace        Delete one whole word left of edit cursor

•CTRL + X, C, V, Z        Cut, Copy, Past, Undo

•CTRL + U                     Shift case of word (sentence, lower, upper case)

•SHIFT+____                 Add Shift to any of the navigation keys for selection.  E.g 
Shift + Ctrl + →  to select one whole word right

3) Editing Keys
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InScribe Shortcut Reference  

InScribe has a built-in Shortcut Reference dialog which lists all the major shortcuts, not just editing and navigation, but 
also shortcuts specific to InScribe. The shortcuts are listed by expandable category. You can use the filter box to narrow 
down the shortcuts by keyword. You can also double click on a shortcut to add them to a favorites list for easier access. 

To access this dialog, go to the View menu and select ‘Show Shortcut Reference’ or use the shortcut SHIFT + CTRL. 

+ S. 

 

Editing Process Walkthrough 

When you start working, you begin by reading, listening, and looking for edits. You also will notice the voice cursor as it 

moves over the content of the document, but will probably not use it much as a beginner. Most of your focus should be on 

locating edits, moving to them efficiently with your navigation shortcut keys, and applying the correction. When editing, 

your natural tendency may be to stop the audio, which is okay. Your workflow should be to locate the next edit, decide the 

type – framework or content and make the correction. Continue in this manner until all corrections identified in the draft 

are made.  

Over time, as you practice and gain experience you should become more comfortable with the navigation keys and 

become less reliant on the mouse. You will start adding some of the editing shortcuts and begin to learn little efficiency 

tricks, such as deleting whole words instead of single characters. You will start to get a feel for the best times to use 

select, cut, copy and paste, and undo. As you become more and more comfortable, you may start to learn how to make 

certain edits without stopping the audio and start to minimize replaying certain portions of the audio. Through experience, 

you will learn when it’s appropriate to keep the audio going while making the edit and when the audio should be stopped 

to make the edit. 

Remember, these editing behaviors will not happen overnight. It takes time and practice. The more you practice, the more 

proficient you will become. 
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Editing with the CORE skills 

What might editing with the core skills look like? Let’s break down an example located in the PAST SURGICAL HISTORY 
section. Imagine the audio is playing back, and we see the voice cursor moving along. As we listen to the audio through 
the PAST SURGICAL HISTORY section, we notice our first couple of edits that are needed. The clinician misspoke and 
corrected their speech in the first sentence, which caused the phrase “Tonsils diet kidney” to appear. Then, in the second 
sentence, we hear clearly spoken text “surgery on both hands for thumb injuries” but ASR missed the word “for” and 
recognized the word “frequently” instead of “thumb”. We stop the audio and make our edits.  

 

There are a few different ways this can be edited. Here is one way to do it: 

1. Use CTRL + DOWN ARROW to move the edit cursor in front of the word “Tonsils” in the PAST SURGICAL 
HISTORY section.  

 
2. Use CTRL + DELETE three times to delete the words “Tonsils diet kidney”.  
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3. Use CTRL + U to upper case the word “Tonsillectomy”. 

 

Next edit is to add the word “for” and change the word “frequently” to “thumb”. Here’s one way to do it: 

 
1. Use CTRL + RIGHT ARROW until the edit cursor is on the word “frequently” and type “for”. 

 
2. Use SHIFT + CTRL + RIGHT ARROW once to highlight the word “frequently”.  

 

 
3. Type the word “thumb”. 

 

We made these two edits quickly by using our navigation and editing shortcuts. You’ll be using these shortcuts the most 
when editing, especially as a beginner.  

 
What do we do next? At this point, we’d start the audio again and look for the next edit using the same technique: identify 

the edit, stop the audio, navigate to it, and edit it using the navigation and editing shortcuts. While we’ve demonstrated a 

set of five core shortcuts, as you edit your own documents, you may find situations where a different set of core shortcuts 

would be used. You’ll learn the best shortcuts to apply to your situation through experience. When you get comfortable, 

the trick is to try to make edits using the fewest number of keystrokes to increase efficiency.  
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Common Editing Scenarios  

Whether you’re a beginner or an advanced editor, remember almost every draft typically has two kinds of edits: framework 

and content. Framework edits are edits to the layout of the document. These are edits to section titles, content placement, 

lists, and ordering. Content edits are edits to the actual paragraphs of text. Depending on the document type, these can 

be freestanding paragraphs such as in a letter, or they can be tied to a section title such as History and Physical. Some 

drafts may have only content edits, and some may have both framework and content edits. 

Framework edits 

1) Missing Title, Incorrect title – occurs when ASR doesn’t properly recognize a title, or the clinician doesn’t properly 

speak a title or speaks the wrong title. 

2) Titles recognized as text – occurs when ASR recognizes certain text that it thinks might be a title based on past 

corrected drafts and recognizes the text in upper case, but not as an actual formatted title. 

3) Mis-ordered title – occurs when the Structured template isn’t configured correctly or a recognized title is matched 

to the wrong section, causing an ordering issue.  

4) Numbered list misrecognition – occurs when A) the clinician doesn’t speak the audio cues to start a list or speaks 

only partial audio cues. B) the clinician speaks something which ASR incorrectly recognizes as a list. 

Content edits 

1) Added words, deleted words – occurs when ASR doesn’t recognize the spoken text and it adds what it thinks 

should be there, or it doesn’t add anything. This can occur because a) the clinician didn’t speak clearly, b) there 

was excessive amount of background noise, or the clinician was dictating on a speaker phone, c) the clinician 

hesitates, self-corrects, or repeats d) ASR just didn’t get the text. 

2) Incorrect punctuation -occurs when ASR adds wrong punctuation. This typically happens when clinicians don’t 

dictate punctuation, so ASR tries to make a best guess where it detects pauses in certain contexts. 

3) Template insertions – occurs with clinicians who use dictation templates (or normals). The clinician will dictate to 

insert the template, e.g., “insert my normal bone injection template”, and this phrase will appear in the draft as 

text. You’ll have to edit this out and insert the actual template. 

Next, we’ll show you some common ways to handle framework and content edits. Note there is more than one way to do 
these edits. In all examples, we always use the least number of keystrokes possible to maximize efficiency. 
 

Working with Titles (Framework Edits) 

There are a couple of different scenarios you can run into with titles. 
 

• Title isn’t recognized at all. In this scenario, the content is lacking the title. 

 
The fix:  

1) Position the edit cursor before the word that belongs to the new section.  
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2) Use CTRL + N to add the title. In this case we’ll add “Past Medical History”. Type the title so it appears 
in the Add Section box, then hit enter to insert. 

 

• The words of the title are recognized as text, but they are not formatted correctly.  

 
The fix:  

1) Position the edit cursor in front of the “P” of the first word “Past”. 
 

2) Highlight the words “Past Surgical History” using SHIFT + CTRL + RIGHT ARROW until all three words 
are highlighted. Then use CTRL + N to bring up the Add Section box, which will automatically fill with 
the highlighted word. Hit ENTER and the title is inserted with the text that follows appearing below the 
title. 

 

• The title was incorrectly recognized. 
 

 
The fix: 

1) With the edit cursor on the title, use CTRL + F6 to bring up the Edit Section box. 
2) Type the correct title. If It’s part of the structured template, it will automatically appear in the title list.  
3) Hit Enter to insert. 

 

• The title was recognized but out of order. 
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The fix: 

1) Review the document before listening to playback, locating edits such as mis-ordering. 
2) Navigate to those sections and move them to the appropriate section using the best keystrokes. 

a. In the above example, place the edit cursor in front of the “H” of the word “HEENT”. 
b. Hit the SHIFT + CTRL + , (comma) to move the section up above the “Plan” section. 
c. Repeat using SHFIT + CTRL + , (comma) until HEENT is under “General”. 
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Working with Numbered Lists (Framework Edits) 

Numbered lists may need to be edited for the following reasons: 1) The list wasn’t recognized because either the clinician 
failed to dictate the list, or the system missed the list cue. 2) the list was partially recognized because either the clinician 
started dictating but didn’t speak the first number (or spoke the first number but forgot subsequent numbers), or the list 
number was recognized as text and not a number. 

 

• The list wasn’t recognized because either the clinician failed to dictate the list, or the system 
missed the list cue.  
 
In this example, no list was identified, and we see a paragraph in the PL section (abbreviated for PLAN). 
 

 

 
The fix: 

1) Position the edit cursor at the beginning of the section. In this example, we’ll assume the edit cursor is at the end 
of the previous paragraph. 

 
 

2) Listen to the dictation and locate where number breaks should be. Position the edit cursor at that location and hit 
CTRL + L to start the list. 

 
 

3) Continue listening to the dictation, determine the next break and hit enter. Repeat until all numbers have been 
added. 
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• The list was partially recognized because either the clinician started dictating but didn’t speak the 
first number or the list number was recognized as text and not a number. 

 
In this example, the list number was recognized as text and not a number 

 
 
The fix: 

1) Position the edit cursor in front of the 1. One way to do this is to hit CTRL + DOWN ARROW a couple of 
times. 

 

2) Hit CTRL + DELETE twice to remove the 1 and period. 
 

 

3) Use CTLR + L to insert the list item. Continue listening through the dictation to determine additional places 
where a list item should occur and hit enter. 
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In this next example, the clinician started dictating, didn’t dictate the first number, but dictated the second and 

third number. 

 
The fix: 

1) Position the edit cursor on the line without the number. 

 

 

2) Use CTRL + L to convert UTI into a list item. 

 

 

 

Working with Content (Content Edits) 

With content, there can be a few scenarios for editing specific words or phrases. Drafts may contain words added that 

were not part of the draft or words that were deleted (or omitted) from the draft. These can happen for a variety of 

reasons.  

 

• In this scenario, the words “who presents on” appear in the text and do not belong.  

 

The fix: 

1) Position the edit cursor after the word “male”. 

2) Hit CTRL + DELETE three times to delete the words “who presents on”. 
 

Alternatively, if the edit cursor was after the word “on” and before the word “snowboarding”, you could use CTRL 
+ BACKSPACE three times to delete these words.  
How you approach this fix depends on placement of the edit cursor. Remember, the goal is to delete the words 
using the least number of keystrokes.  
 



 

 

    

    

35 

eScription One 
 

 Jan 2020 

 

© 2020 Nuance Communications, Inc. All rights reserved. 

At this point, the text should look like this, but notice also the red box shows a couple of words missing. Listening 
to the audio we hear the words “status post”. These words were left out (or deleted) from the recognized text. 

 
 
Now the edit cursor should be in between male and snowboarding where you’ll type “status post” so it looks like 
this highlighted in green. 

 
 

Another common scenario is working with incorrect punctuation. There are a few reasons for incorrect punctuation. Often, 
this happens when the clinician doesn’t speak punctuation and the system attempts to add it based on pauses. 

 

• In this scenario, notice the period after “hypertension” followed by “Hyperlipidemia 
hypothyroidism”.  

 
Listening to the audio, we hear the clinician speaking what sounds more like a list of medical conditions. 

 
The fix: 

Note: Ensure you have “Capitalize First Letter of Sentence As You Type” enabled under File > Options > 
Spelling. 

1) Position the edit cursor after the “n” in hypertension, then type a comma. The period is removed, the comma 
is added and the “H” in “Hyperlipidemia” is automatically set to lower case. 
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2) Navigate to the space after Hyperlipidemia and add a comma. 

 
 
Still another scenario is with template insertions. Often, a clinician uses a variety of templates to help complete the 
dictation. With ASR, the template is not automatically inserted. The clinician will speak the words to insert the template, 
and the MLS will need to search for and insert the template.  
 

• In this scenario, the clinician requests to insert the bone injection template.  
 

Listening to the audio we hear the request and see it in the text. 

 

The fix: 

1) Position the edit cursor in front of the “P” in the word “Please”. 

2) Highlight the entire line with SHIFT + CTRL + DOWN ARROW and hit delete to remove the text. 

3) Use SHIFT + CTRL + G to insert the template. 

Advanced Editing Skills 

Advanced editing skills incorporate more editing techniques into your workflow to help further increase efficiency. We 

recommend working on these after having good command of the core editing shortcuts. 

Editing During Playback  

Editing during playback is editing when the audio is playing while trying to minimize start/stop editing. To learn this skill, 

start by making smaller edits during playback such as editing articles and prepositions, and then work your way up to 

larger edits, such as words and phrases. Note, this technique does not apply in all cases. There will be times when it is 

necessary to stop the audio for more complex edits. As you practice this skill, you’ll eventually learn when you can keep 

the audio going and when you should stop the audio. 
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Adjusting Playback Rate 

This skill allows you to control the playback speed. Knowing how to change the rate of playback is another way to 

increase efficiency.  

You can speed up, slow down, or return the dictation to normal speed using the keyboard shortcuts: Ctrl+T, Ctrl+E, and 

Ctrl+R.   

• Ctrl+T to speed up the dictation.  

o Use with clinicians who speak slowly.  

o Speeding up on these dictators allows you to move through the draft quicker and more efficiently.  

o This option is great to use with more consistent dictators where less edits are needed.   

• Ctrl+E to slow down the dictation.   

o Use on fast dictators, or bad dictators where more edits are needed.   

o Slowing down also gives you time to think about which keystroke to use to make the edit.   

• Ctrl+R to return the playback rate to normal.   

o Use when dictation was sped up or slowed down and you wish to quickly get back to normal playback 

speed.  

o For example, you sped up the playback to quickly re-read a particular section and you want to bring the 

playback to normal. 

Any time you can make a speed adjustment, it can go a long way towards improving efficiency. 

Using the Voice Cursor  

The voice cursor is a powerful editing tool and is the cursor that highlights each word as the audio is played back. You can 

attach your edit cursor to the voice cursor, which allows you to read and navigate to edits at the same time. When you 

come to an edit, you separate the edit cursor from the voice cursor, make the edit, and then reattach the edit cursor and 

start the process again. 

This feature has several advantages. First, it allows your eyes to follow along with each word as it is played, which helps 

you listen and read more efficiently. Second, when used with the Attach Edit Cursor to Voice Cursor option, it keeps your 

edit cursor moving with the text, allowing you to navigate more efficiently to edits, while keeping the edit cursor close by.  

Third, it can be used to start playback from virtually any word in the draft.  Having this ability eliminates the need for fast 

forward and rewind.  Fourth, for those tough to hear spots, it can be used to re-play a portion of the audio without having 

to rewind.  Finally, it provides a reference point to return to when you read ahead. 

There are two methods that can be used when editing with the voice cursor during playback. You can edit with the voice 

cursor detached or attached on playback. We’ll explore these in more detail in the next sections. 

Editing with the Voice Cursor Detached 

This is the preferred method and gives the user more control when editing. In this scenario: 

1. Start playback. 

2. Use CTRL + SPACE to attach the edit cursor to the voice cursor. When the two cursors are attached, the voice 

cursor will turn blue. 

3. When you come to an edit, separate the edit cursor from the voice cursor by using any of the ARROW KEYS. 

Stop the audio if necessary, or keep it going if you are comfortable editing during playback. Next, make the edit. 

4. Use SHIFT + CTRL + SPACE to bring the playback back to your edit cursor and use CTRL + SPACE to reattach 

the edit cursor to the voice cursor.  

5. Repeat steps 3 and 4 until you are finished editing.  
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Tip: When you first start using the voice cursor, slow down the audio to help keep up with the playback while reading and 

editing.  

Editing with the Voice Attached on Playback  

With this method, the edit cursor will automatically be attached to the voice cursor as soon as the audio is played. Some 

users prefer this method when working with a foot pedal. In this scenario, 

First, ensure this feature is enabled by going to File > Options > Playback and checking the box “Attach voice cursor on 

play”. 

1. Start playback, the edit cursor is immediately attached to the voice cursor. When the two cursors are attached, 

the voice cursor will turn blue. 

2. When you come to an edit, separate the edit cursor from the voice cursor by using any of the ARROW KEYS. 

Stop the audio if necessary, or keep it going if you are comfortable editing during playback. Next, make the edit. 

3. Use SHIFT + CTRL + SPACE to bring the playback back to your edit cursor and use CTRL + SPACE to reattach 

the edit cursor to the voice cursor. OR, if you stopped the audio, start it again. However, note that if the audio is 

further ahead, the edit cursor will attach and jump further into the transcription.  

4. Repeat steps 2 and 3 until you are finished editing.  

 

As you become more comfortable, you will find using the voice cursor works well with editing during playback and 

adjusting the playback rate. Combining all three of these skills will further increase your editing efficiency. 

Best Practices  

These are additional techniques to further enhance your editing skills.  

Focused Listening 

Focused listening is making a conscientious effort to really listen to what the clinician is saying. There is a difference 

between hearing and listening. When you hear something, you notice sound, but you do not actively think about what you 

are hearing. When you listen to something, you are actively engaged and thinking about what you are hearing.  

This skill shouldn’t be anything new to the MT who does traditional transcription, but in the MLS editing world, it becomes 

more important. Not focusing your listening may lead to missed edits and mistakes. When you edit, it’s important to listen 

to the spoken words, but it’s also equally, if not more important, to listen for context of those spoken words. This will 

enhance your ability to quickly locate edits in draft documents. 

Listen for: 

o Gender 

o Sound-alike words 

o Numbers 

o Medications 

o Account specific discrepancies 

o Missing or added words 

o Speaker intent, take in entire picture instead of individual pieces 

o Facts, figures, and ideas 

Remember to always question things you do not understand. 
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The Power of Suggestion 

What is the power of suggestion? It’s when you hear and read what you think is the same, when actually it is not.  At one 

time or another, we’ve all run across a case when we transcribed something we thought was correct, only after re-

listening to it, hear something different. When we don’t focus our listening, we can sometimes misunderstand what we 

hear. This situation is what is commonly known as the Power of Suggestion. 

With editing, the power of suggestion can be more of an issue because all transcription is recognized by ASR. If not 

paying close attention to the audio and text matchup, you can easily be misled into thinking what you heard and saw was 

correct when it was not, and portray the wrong information. 

Power of Suggestion often occurs with: 

• Sound-alike Words – words that ASR recognized incorrectly because they sounded alike, e.g., dictated “drug 

eluting stent” recognized “drug-alluding stent”. 

• Repetitions – clinician loses train of thought and repeats what was said, or pauses dictation and forgets what 

was already dictated, or repeating words while dictating  

• Self-corrections – clinician misspeaks, realizes it and speaks correction 

• Words not transcribed by ASR, especially articles and prepositions  

• Accented Dictators – certain word pronunciations spoken differently  

• Poor dictation – bad audio, poor speaking habits 

By focusing your listening on content and paying attention, you can avoid the Power of Suggestion. 

Using Draft Output 

A major advantage to editing is having the entire transcribed draft output. This can be a valuable tool when editing for the 

following reasons: 

• You know what is said 

o You have the entire transcribed draft and can make editing decisions based on what is said 

• You can review the draft before listening 

o You can quickly locate obvious edits such as left/right discrepancies, dictation template insertion 

instruction, misformatted titles, misformatted lists, etc. 

• You have all the sentences and phrases 

o You can easily read and get context of what is said to aid in editing decisions. 

• You can learn new terms 

o ASR may output terms unfamiliar to you; you can use this as a starting point to research. 

Using the draft output can provide many advantages to the editing environment and make you a more productive and 

efficient editor. 

Unnecessary Editing 

Unnecessary editing is making corrections to a draft to make it more readable without affecting medical accuracy or 

meaning. When transcribing, it’s easy to change what is spoken as it is typed, improving grammar, readability, and in 

general, making clinician reports look better. When editing drafts, however, this is not easy or recommended. The ASR 

system produces highly accurate results and gets most of the words right. In cases were the draft does not exactly match 

the dictation, but the meaning is close, an MLS should focus on the meaning of the dictator’s words and consciously avoid 

making an edit for purely cosmetic reasons. The most productive editors are those who make edits which are necessary 

to the medical accuracy of the report. 

Unnecessary editing often involves changes to grammar, punctuation, dictation style, and readability. The job of the MLS 

is to ensure the medical accuracy of the submitted document, not to unnecessarily “pretty up” the document.  
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Goals of Unnecessary Editing 

• Edit for content, not cosmetics. 

• Make necessary edits - edits that are needed to make the report medically accurate. 

• Save keystrokes and improve efficiency. 

If uncertain, always edit: 

• Discrepancies such as Left or Right, or Gender Discrepancies 

• Measurements in Lab Results 

• Inconsistencies in Medication Dosages 

 

Applying Editing Skills 

In this section, we will pick an example and walk though some of the edits, discussing how to approach this from a 
beginner and advanced editor perspective.  

 

Correcting Obvious Edits 

Look at this draft below. Whether you are a beginner or an advanced user, the first step is to scan the draft and search for 
any obvious edits that can be made before starting playback. These are typically edits that can be made in 30 seconds or 
less.  
 

 

In this case, our scan shows we can quickly fix the following: 
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1. “Tonsils diet kidney tonsillectomy and adenoidectomy” – the first 3 words do not sound as if they should be part 
of this sentence. However, the last three words, tonsillectomy and adenoidectomy, do. 

Most efficient way to edit this:  

a. CTRL + F, type “tonsils” in the find box, hit ESC twice, and the cursor is at the beginning of Tonsils. 

 

b. CTRL + SHIFT + RIGHT ARROW to highlight all three words and hit DELETE. 
 

 

c. CTRL + U to upper case “Tonsillectomy”. 

With completed edit looking like this: 
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2. The word “Assessment” should have been a title. 

 

Most efficient way to edit this:  

a. Use CTRL + F, bring up the find box and type in “Assessment”. Hit ESC to close find.  

b. Use CTRL + N to bring up the “Add Section” window. In this case, the word “Assessment” will be prefilled 

because it’s part of the template. Hit ENTER to add the section. 

The completed edit looks like this: 

 
3. The “Plan” section should have been recognized as a list.  

 

Most efficient way to edit this:  

a. Navigate to the number one. Hit CTRL + DELETE twice to delete the number. This is not an actual 

formatted number; it was recognized as text.  

b. Use SHIFT + CTRL + END to highlight all the text 

 

c. Use CTRL + L to convert highlighted text into bulleted list items. 
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The complete edit looks like this: 

 

Making Edits with Audio Playback 

Having completed the obvious edits, we move onto the rest of the edits with the audio. Beginners will play the audio while 

reading the text, find an error, stop the audio, and make the correction. The key is to minimize mouse usage and 

concentrate on the keyboard shortcuts for navigation and editing. Depending on comfort level, this may be using 

navigation shortcuts at first but following the strategy in the Shortcuts to learn first section of this document. You will 

eventually build to incorporate editing shortcuts as well.  

Advanced MLS’s have all editing and navigation shortcuts mastered and will incorporate attaching the edit cursor to the 

voice cursor to carry the edit cursor along with the audio. They may make edits while the audio is playing and use the 

voice cursor shortcuts to bring the playback back to the edit, or they may slow down and speed up the audio where 

appropriate. Or, the edit may be too complex to keep the audio going. Edit execution is dependent on the level of 

experience of the MLS.  

Let’s look at an edit at the beginning of the draft and show the strategy of how a beginner and an advanced MLS would 

make this. In this example there are only two edits. 

 

Beginner MLS 

1. Play audio, listen and read text. Notice the words “status post” missing after the word “male” and before 

“snowboarding”. 

 
 

2. Stop the audio, move the edit cursor after the word “male” using CTRL + RIGHT ARROW a few times and type 

“status post”.  
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3. Resume playback reading and listening, while looking for the next edit. This new edit is found after the words “AC 

impingement”. The word missing is “and”. 

 

4. Stop the playback, use DOWN ARROW to move the edit cursor to the line with “AC impingement”. Use CTRL + 

LEFT ARROW to move the edit cursor between the words impingement and history. Next, add the word “and”. 

Resume playback to listen to the remainder of the paragraph.  

 

After all edits, the text will look like this. Edits highlighted in blue.  

 

Advanced MLS 

1. Start playback, use CTRL + SPACE to attached the edit cursor to the voice cursor, then read text and listen to the 

audio. Notice “status post” is missing between “male” and “snowboarding”. 

  
 

2. Use LEFT ARROW key to separate the edit cursor as “snowboarding” is highlighted. While audio continues to play, 

type the words “status post”. 
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3. Use SHIFT + CTRL + SPACE followed by CTRL + SPACE to start playback from edit and reattach the edit cursor to 

the voice cursor. Resume listening to the audio. Scan the words ahead of playback and decide to speed up playback 

by hitting CTRL + T a few times. 

 

4. Approach line that has “AC impingement”. Let audio play. Notice the word “and” after the word “impingement” is 

missing. Use CTRL + R to return playback to normal.  

 

 
 

5. Use the LEFT ARROW to break the edit cursor and move it after the word “history”. Type the word “and” while the 

audio continues to play.  

 

 
 

6. Bring playback to the edit with SHIFT + CTRL + SPACE, then reattach the edit cursor to the voice cursor with CTRL 

+ SPACE. Let the audio continue to play while reading and listening to the rest of the text in the paragraph.  

 

After all edits, the text will look like this. Edits highlighted in blue.  
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Support 
Get assistance for ShadowScribe ASR and all other eScription One applications: 

Phone Support 1-800-858-0880 

Support Email: eSOne@naunce.com 


